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Brief History of Legacy Family Tree 

Legacy, for short, is a genealogy computer program to assist in organizing, planning, and sharing 

your family history information. Its development began in the mid 1990s as a personal project 

to develop software that would do more than what was available at the time. The programmers 

hoped it would be ready with six months of planning. Three years later, in 1997, Legacy 2.0 was 

announced as the first public release. 

In December 2000, Millennia Corporation announced that Legacy 3.0 could be downloaded for 

free. Previously the retail price was $49.95. Two versions were made available – the free 

standard edition and the deluxe edition. The free standard edition contained most of the 

features that users previously paid for. The deluxe edition added special features that were 

hidden unless the user purchased an “unlock code.” 

Today (2014), Legacy is used by genealogists around the world and continues to be one of the 

leading family tree programs. It is currently being translated into 21 languages. At present, it is 

available in Afrikaans, Czech, Dansk (Danish), Deutsch (German), Français (French), Italiano 

(Italian), Nederlands (Dutch), Norsk-Bokmål (Norwegian), Norsk-Nynorsk (Norwegian), Suomi 

(Finnish), Svenska (Swedish), English (Australia), English (Canada), English (United Kingdom), 

and English (USA). 

Standard vs. Deluxe Edition 

The standard edition includes most of the functionality for basic users – creates reports, web 

pages, merging, To Do List, creates CDs, etc. The deluxe edition adds 98 additional features – 

some big, some small. A thorough comparison of the differences is available at: 

 http://www.legacyfamilytree.com/DeluxeEdition.asp 

Getting Started - Importing 

If your genealogy information is currently in a different genealogy computer program, you do 

not have to re-type it all into Legacy. Legacy can import the information, provided that the 

other program can convert it to a compatible format. If the other program can create a 

GEDCOM file, then Legacy will import it. GEDCOM is an acronym for Genealogical Data 

Communications – it is a file format created to assist in transferring data from one genealogy 

computer program to another. If importing from PAF or FamilySearch’s Family Tree, no 

GEDCOM is necessary. 

For instructions on creating a GEDCOM from other software, either see the software’s 

instructions, or visit: 
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 http://www.legacyfamilytree.com/tipsGEDCOMfiles.asp 

After you create the GEDCOM, now you need to import it into Legacy. Follow these steps: 

1. Click on the File tab. Click on Import. Click on Use Import Wizard to help with any 

import. 

2. Select A Different Program. Click Next Step. 

3. Legacy will now ask a few questions. Just answer them, and you will end up looking at 

your imported family in the Family View. 

Your family file is now ready to use. 

Starting from Scratch 

If your genealogy information is not already in another genealogy computer program, you can 

start fresh by using Legacy. After installing Legacy, click on the Create New Family File button. If 

you have already started using Legacy, to create a new family file: 

1. Click on the File tab, and click New File. 

2. Select Start a New Family File. 

3. Fill in as much as you know about your family. Then click Finished. 

4. In the File Name field, enter the name of your new Legacy Family File, and click Save. 

Your Family File is now ready to use. 

Continue adding other family members. This is simple if you can remember to use the Add 

menu. Just click on the Add menu, and select who you want to add. 
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How many family files should you manage? 

At some point, users of any genealogy computer program, including Legacy Family Tree, will ask 

the question, "Should I split my database?" 

The reasons given for wanting to split a database are many: 

• you may want to keep your spouse's genealogy in a separate database 

• you may want a separate database for each line you're working on 

• you may want to share just a portion of your database with another relative/researcher 

• you feel that splitting your database would make more room in your main database 

Before making the plunge and splitting your database, consider these cautions: 

Intermarriages 

Suppose you separated your genealogy from your spouse's, and they are now in two separate 

family files. As your research progresses, you get further and further back in time. You begin 

researching a family that seems all too familiar - maybe you've researched it before. In fact, you 

had previously researched it - on your spouse's side. 

The further back you trace, the chances are higher that you and your spouse have common 

ancestry. Such is the case with my wife and me. Back in the 1580s, we share a common 

ancestor - Stephen Hopkins is my 12th great-grandfather. He is also my wife's 12th great-

grandfather. If I had split my database so that my wife's database was not included in mine, I 

may not have picked up on the fact that we were 13th cousins. I may have even duplicated our 

research. 

This is one of the reasons why I keep all my genealogy in the same database. 

Duplication of data entry 

When I first started my research, I had eight separate databases. One for each of my eight 

great-grandparents. I thought it'd be easier to research this way. The descendants of these 

great-grandparents number into the thousands. In fact, because I am a descendant of each of 

these great-grandparents, I entered myself into each database. 

The challenge this presented was that every time I needed to update my information, or I 

became a new dad, or even if I needed to update information on any of my cousins, I had to 

update the same information in at least two of the databases. If I needed to update my 

personal information, I would have to update it in all eight. Chances are greater that I would 

make a typo in at least one of them. 
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Printing 

If my database were separated from my wife's, printing a pedigree chart or other reports 

becomes challenging. For example, I could not print cascading pedigree charts beginning with 

my son, Evan, because on the first chart, only his paternal side of the family would appear. If all 

my genealogy were combined into one family file, this would not be a problem. 

But won't it get too big? 

We have "test databases" of Legacy where we've linked over a million individuals. There are 

two potential challenges when working with databases of this magnitude. First, navigation 

becomes a bit slower. Second, the size of the database is considerably larger than one of just a 

few thousand. However, we haven't run into too many researchers that claim to have 

researched a million individuals - I'd love to see their documentation.... 

It's still okay... 

There may still be good reason to split your database. I've created a separate research database 

to help me in tracking all the different Alanson Browns. Once I have positively identified my 

Alanson Brown, using Legacy's split screen tool, I can drag and drop him and his family into my 

personal database. 

I've also created a separate database where I indexed the tax lists of Washington County, 

Tennessee from 1778-1850. Now doesn't that sound like an exciting way to spend a weekend? 

Before you go ahead and make your split, carefully consider the above implications. 
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The Essentials: Names 

In genealogy we want to accurately record the names of each individual. Names have four 

parts: 

1. Title – prefix 

2. Given name 

3. Last name or Surname 

4. Title – suffix 

Many given names and surnames are interchangeable. Alexander may be a given name or a 

surname. The same is true for names such as Taylor, Thomas, and Martin. 

Most genealogists were taught to always record the surname or last name in UPPERCASE to 

avoid confusion between the given name and last name. Technology and software have 

evolved, so this rule is no longer necessary. However, Legacy has several options for displaying 

surnames: 

 Show /Surnames/ within slashes 

  John /Smith/ 

 Show SURNAMES in upper-case letters 

  John SMITH 

 Show /SURNAMES/ within slashes and upper-case letters 

  John /SMITH/ 

 Show Surnames as entered 

  John Smith 

You also have the same four options for printing surnames when you print a report. 

As an example, you could: 

1. Enter the names in mixed-case   John Henry Smith 

2. Display the surnames within slashes   John Henry /Smith/ 

3. Print the surname in upper-case letters  John Henry SMITH 

When entering the last name of a female name, always use her maiden name. 
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Title – prefix. Titles such as Reverend, Dr., Sir and Colonel are not part of the given name for an 

individual. You will not find them on birth/baptismal records, but they may be very helpful in 

tracing your ancestors and should be recorded as a name title-prefix. 

Title – suffix. Titles such as Jr., Sr. may be part of the individual’s name but post nominal letters 

such as PhD, MD, and DDS are not. However, both should be recorded as name title-suffix. 

Nicknames, other spellings, and aliases. When searching databases online, browsing indexes in 

books, or performing original research, we may not find what we are looking for, simply 

because we have not searched for all known variations of the name. 

While researching Asa Frederick GOAS, I have found these variations of his names: 

• Fredrick GOAS 

• Asa GOAZ 

• Frederick GOAZ  

• Frederick GOES 

• Frederick GOEZ 

• Frederick GOOZ 

• Frederick GOZ 

I also found a land record for John McCALL. In the same document, his surname was spelled 4 

different ways: 

• John McCALL 

• John McCAUL 

• John McCAL 

• John McCALE 

When doing your research, it is vitally important to search for all variations. If you record these 

variations in Legacy's Alternate Names section, these names can optionally be printed on 

reports. Follow these simple steps: 

• From either the Family View or the Individual's Information screen, click on the 

Alternate Names icon 

• To add a new name, click on the Add button. Enter the name, click Save, then add its 

source. 
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Include Alternate Names in Reports 

When printing reports, be sure to turn on the option to include these alternate names. Follow 

these simple steps: 

1. Click on the Reports button and select the desired report.  

2. Click on the Report Options button.  

3. On the Include tab, check the Alternate given and surnames option.  

4. Close. Preview. 

Below is a portion of the Family Group Record. At the top is the list of alternate names. With 

this information included in the report, we are more likely to remember to search for these 

alternate names. 

 

 Show Alternate Names in Index View and Name List 

The alternate names can also be included in the Index View and Name List (deluxe edition only). 

In the Index View: 

1. Click on the Options button in the upper right  

2. Select Include AKAs in List 

In the Name List: 

1. Click on the Options button at the bottom  

2. Select Include Alternate Names 

The alternate name will be preceded with a ~. The magic of including these names in these lists 

is that you don't have to remember the "correct" spelling of the name. Once you locate any of 

the alternate names, they all point to the same person.  
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Legacy Resources 

Step-by-step instructions. You can reach the step-by-step instructions in Legacy by clicking on 

the Help tab and clicking on the Help Index button. You can then access the step-by-step 

instructions by clicking on the green Step-by-step instructions link.  

Videos. Geoff Rasmussen, has produced two volumes of video training available on CD. The 

CDs, which are viewable on your computer, not only teach how to use Legacy, but how to 

correctly apply your genealogy knowledge. In other words, you will get professional advice on 

managing your research efforts using Legacy. The following tutorials are available: 

 Volume 1 | 5-CD set | $32.95 | 3 1/2 hours 

• Legacy for Beginners. This video walks the beginning Legacy user through the basics of 

the program. View it free here. 40 minutes. 

• Mastering Legacy: Names, Dates & Places. Learn the do-it-right-the-first-time rules of 

data entry. 39 minutes. 

• Your 12-Step Checklist to Using Legacy. Every Legacy user should follow these 12 steps 

when working with their family file. 50 minutes. 

• Legacy's Ultimate Guide to Sources. Genealogy without documentation is mythology. 

Learn all about proper source documentation. 41 minutes. 

• Researching with Legacy: Mastering Events and Chronologies. Learn how to properly 

enter and cite the documents you find. 42 minutes. 

 Volume 2 | 4-CD set | $32.95 | 4 1/2 hours 

• Tagging and Searching Made Easy. Learn how to take advantage of the searching and 

tagging features in Legacy. 34 minutes. 

• Creating & Sharing Perfect Reports. Become an expert in creating and sharing reports. 

58 minutes. 

• Insider's Guide to Legacy: Tips & Tricks. Get the "insider information" about Legacy. 40 

minutes. 

• Video Guide to Working with Digital Pictures in Legacy. Learn the "before-scanning-

your-first-picture rules" and the ins/outs to using pictures in Legacy. 52 minutes. 
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Printed User’s Guide. Includes over 36 lessons and tutorials plus plenty of pictures. Features a 

soft cover, easy-to-read font, 396 pages, fully-illustrated, indexed, available in PDF format. 

Legacy News. New genealogy and Legacy tips are published nearly every day. The headlines are 

available in the Legacy News section of the Legacy Home tab. To read the complete article, just 

click on the title. An Internet connection is required. To receive these tips as a weekly email, 

enter your email address in the subscribe box in the upper right corner of 

http://news.LegacyFamilyTree.com. 

If you are new to Legacy, visit http://legacynews.typepad.com/legacy_news/legacy-tips-for-

beginning-legacy-users.html for 16 brief articles that will get you going on the right foot. 

Legacy User Group mailing list. This is a mailing list for all Legacy users to share ideas and teach 

each other. Once you have subscribed to the list (free), you can send and receive messages 

from other Legacy users. To subscribe, visit http://www.legacyfamilytree.com/LegacyLists.asp. 

Legacy Family Tree webinars. Sign up for our free webinars at www.FamilyTreeWebinars.com. 

Webinars are online seminars that you watch from your computer. Topics from nationally-

known speakers. 

Telephone support.  

 Sales: 1-800-753-3453 (U.S. and Canada) or 1-623-444-8918. 

Support: 1-425-788-0932. Leave a message and your call will be returned in the order 

received. 

 Fax: 1-425-940-1610. 

Email support. 

 Information: info@legacyfamilytree.com 

 Orders and sales questions: sales@legacyfamilytree.com 

 Technical support questions and help: support@legacyfamilytree.com 

http://news.legacyfamilytree.com/

